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Introduction

The IAB Europe CMP Validator (Validator) is a tool that helps Consent Management Providers
(CMPs) and publishers check their compliance with the IAB Europe Transparency & Consent
Framework (TCF) Technical Specifications and Policy.

Installation

Chrome browser extension

The Validator is a Chrome extension. This enables the tool to analyse live CMP installations on
any site. The extension can be used in the Windows or macOS versions of Chrome. It is not
possible to add an extension to mobile or tablet browsers.

Non-Web based CMPs

If you have an in-app or non-Web based CMP you will not be able to use the Validator - please
submit the appropriate form below as part of the compliance process instead of using the
Validator:

e V1.1 non-Web based CMP form
e V2.0 non-Web based CMP form

Requesting access to the Validator

The Validator has been published to the Chrome Web Store in private mode. This means it
does not appear in searches and is only available to authorised users.

Only CMPs registered with the Transparency & Consent Framework (TCF), or publishers
running an IAB TCF registered CMP, are authorised to use the tool.

A Gmail account is required to use the tool. To request access, please send an email from your
organisation’s domain to: icf.compliance@iabeurope.eu, with details of the Gmail account you
wish to use.



https://forms.gle/zVrb3DHRe4fXqRtQA
https://docs.google.com/forms/d/1P7WyUJ4gzzAzyxmLfl0ZkVueQMH61koxNoQjgzG39bc
mailto:tcf.compliance@iabeurope.eu
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Installing the extension

Once IAB Europe has confirmed that your Gmail account has been authorised to use the tool,
follow these steps to enable the extension in Chrome:

1. Sign.in to Chrome
2. Add extension to Chrome
3. Allow extension to run in incognito mode

1. Sign in to Chrome

You must be signed in to Chrome with the Gmail account you sent us to install the extension.

You can sign in using the icon next to the settings in the top right hand corner of the browser.
Note that the icon on your browser will be different to the one shown below.

@ sboutblank b4 +
< & ‘D‘ @ aboutblank T u & P . N -

Sync and personalise Chrome across your

devices

Ov Passwords
B Payment methods

Q@ Addresses and mare
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2. Add extension to Chrome

Use this link to view the extension in the Chrome Web Store

https://chrome.google.com/webstore/detail/iab-europe-cmp-validator/mfgfmhifapognpcbheanamlejcejcebc?authuser=1

Now click the ‘Add to Chrome’ button.

Note: if you get a ‘404’ error when accessing this URL it means your Gmail account is not
yet authorised to use the tool. Try again in an hour.

— O >
& |AB Europe CMP Validator - Chre X +
- c O B httpsy//chrome.google.com/webstore/detail/iab-europe-cmp-validator/mfgfmhifapognpebhean... 3% % o &6 £
- chrome web store ﬂ verdon@iabeurope eu v

Home > Extensions > |AB Europe CMP Validator

IAB Europe CMP Validator
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Confirm you want to add the extension by clicking ‘Add extension’.

Home > Extensions > IAB Europe CMP|

& [|AB Europe CMP Validator - Chre X + - 2 i
“~ c 0O @ https://chrome.google.com/webstore/detail/iab-europe-cmp-validator/mfgfmhifapognpcbhean... 3t % o & v
. § Add'IABE CMP Valid e -
- chrome web store iab: upe alidator’s ﬂ verdon@iabeurope. eu v

¢ |AB Europe CMP Validator
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Chrome will then confirm that the extension has been added.

= O X
& |AB Europe CMP Validator - Chre X +
“~ c 0O @ https://chrome.google.com/webstore/detail/iab-europe-cmp-validator/mfgfmhifapognpeb...  ¥¢ % 0 &6 re
P chrome web store " ;— IAB Europe CMP Validator has been by
Iﬂbi added to Chrome
Use this extension by clicking on this icon.
Home > Extensions > I|AB Europe CMP Validator Manage your extensions by clicking Extensions in the
Tools menu.
. . - |ABEurope CMP Validator Remove from Chrome
2
Iab' Offered by: |AB Europe
0 ‘ Developer Tools | S 4users
QOverview Reviews Related
& (2 A
Octotree SEO & Website Analysis Redux DevTools Google Maps Platfoerm ...
* &k k& 971 kA ok ok 647 ok ok ok k467 * % Ko 1,587
o =
= | 7 Js
Print for Google Chrome Page Ruler Eye Dropper Toggle JavaScript
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3. Allow extension to run in incognito mode

Some of the tests need to be run using Chrome’s incognito mode. Follow these steps to allow
the extension to run when you launch an incognito browser window.

Go to Settings > More tools > Extensions

= a X
& 4B Eurcps CMP Validator - Chre X
& > C {Y @& nhtips//chrome.google.com/webstore/detail/iab-europe-cmp-validator/mfgfmhlfapognpcb... ¥ Fﬂa Qo &6 ol
]
& chrome web store
New tab Ctrl+T
New window Ctrl+N
Home > Extensions > IAB Europe CMP Validator Newpiate Widi] CarlShiftah
Histary »
. . Dawnloads Crl+)
. . ¢ |ABEurope CMP Validator Bookmarks »
5
3
Iub' Offered by: |AB Europe Zoom - 00% - e
o] ‘ Developer Tools | & 4users Print... Ctrl+P
Cast..,
Find... Ctrl+F
More tools 5 Save page as...
) Create shortcut...
Overview Reviews Related Edit Cut Copy Paste
Clear browsing data...  Ctrl+Shift=Del
Settings
Extensions
Help »
Task manager Shift+Esc
Exit
Developer tools Ctrl+Shift=
& (-2 ) B Managed by your organisation
Octotree SEO & Website Analysis Redux DevTools Google Maps Platform ...
% ok 971 ok ke k ok 647 %k ok k ok 467 ek k3 1587
= -
= i Z ¥
Print for Google Chrome Page Ruler Eye Dropper Toggle JavaScript
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Find the IAB Europe CMP Validator extension and click on ‘Details’.

W Extensions b4 + - 2 b3

& c 'ﬂ' & Chrome| chrome://extensions @ i 'Il Q0 6

= Extensions Q, Developer mode

IAB Europe CMP Validator

ope

iab:

eul

Details Remove 9
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Now toggle the ‘Allow in incognito’ option.

W Extensions x  +

< C ft ® Chrome | chromey/

Load unpacked Pack extension

nsions/?i

Update

P, ahhdp jcngpdndjbph

« background page

Permissions

This extension requires no special permissians

Allow in incagnita
Warning: Gaogle Chrome cannot prevent extensions from recarding your browsing history. Ta disable
this extension in incognito mode, unselect this option.

Allow access to file URLs

Collect errors

Open extension website

Source

Unpacked extension

Loaded from: ~\Dropbox\Code\lAB\iab-cmp-validator-browser-pluginymast g ions\1.1
abeuropecmpvalidator_chrome_webstare

That’s it, you're done!

11
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Getting started

Once installed, you can browse to any Website and click the icon in the top bar to run the CMP
Validator.

The tool works by adding code into the actual Website being viewed. Note that on sites that load
many 3rd party scripts, it can take a few seconds for the CMP Validator scripts to run.

Radio Times Home | TV and Rac. X +

= O
&« - C {t @& htips//www.radiotimes.com * FEEI Q ﬁ *

NEXCHOME

The Launch Pad
Shop now .

Latest news

Neil Gaiman changed the
Good Omens TV ending so

12
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Clicking the icon in the top bar will activate the CMP Validator which will appear as a slider that
overlays the site.

Radio Times Home | TV and Rac: X +

& C {}y & https//www.radiotimes.com

iab: CMP VALIDATOR

TECHNICAL COMPLIANCE CHECKS (TCF V1)

Is the consent siring created after affirmative action by the
user?

©

Did all GMP API required functions retumn a response?

Is the CMP id registered?

Is the CMP API found when an euconsent cookie is found?
Is the GVL version format correct?

Is the current or penultimate version of the GVL being used?
Are all vendors being set when using global scope?

Is a 3rd party euconsent cookie found when using global
scope?
Is the local euconsent cookie empty when using global
scope?

10 Is the max vendor id set to the highest id in the GVL?

8 8 868 ee

Logena: |[Pas8) WG| Manual Check Required | Not Appiicable

Save to CSV | Download CSV | Clear CSV Results Presented by IAB Europe (v1.1)

You can dismiss the CMP Validator by clicking on the icon again, using the ‘X’ in the top right
corner or clicking outside of the CMP Validator user interface.

13
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Sites that do not have a CMP that supports the TCF

If you run the CMP Validator on a site that does not have a CMP that supports the TCF you will
see the following message.

FT' Financial Times b4 +

& > C Y @& htps//www.ft.com w B Q &6

CMP VALIDATOR

NO CMP FOUND THAT
SUPPORTS THE TCF

Save to CSV | Download CSV | Clear CSV Results Presented by IAB Eurcpe (v1.1)
e

14
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Some sites implement a Content Security Policy that prevents unknown scripts from running on
the page - in these cases the CMP Validator is not able to run and the following message will be
shown.

g2 5] X
¥ Google News X +
< Cc O @ https://news.google.com/?hl=en-GB&gl=GB&ceid=GB:en w iab. e
—_ news.google.com says aes
= Google News Q sPe . # 0 @
THIS SITE DOES NOT ALLOW THE CMP VALIDATOR TO RUN
B Topstories “
} 1es
2 Foryou
) UK weather: Temperatures plunge to Cambridge
¢ Favourites
-15.4C as more snow forecast
Q Saved searches Sky News - 2 hours ago Rain s
o
« UK weather: Heavy snowfall sweeps 1°¢
eastwards causing disruption
F United Kingdom BBC News - one hour ago Today Sat Sun Mon Tue
@ World « Rush-hour traffic alert as snow hits oe ®
southern England and Wales today =
9 Local The Times + Today 3C  4°C 8°C 9°C 9°C
1C  -3C  2°C  2C  6°C
By « Avoid A30, A38 and M5 if possible says
Business :
Highways Agenc
IS RIS C | F | K Moreonweather.com
Plymouth Live + Today
{8} Technology
+ Rush-hour snow warning as UK
[ Entertainment temperatures hit seven-year low Fact check
Sky News - Today
oo Sports B View full coverage A Is Disney's Goofy Character
Actuallva Cow? =

Note: only a couple of sites have been found where the CMP Validator could not run, out
of 100s tested.

15
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Using the CMP Validator

The Validator has three key feature areas:

1. Compliance checks
2. CMP information
3. CSV results

Compliance Checks

The compliance checks are split into two sections:

e Technical compliance checks
e Policy compliance checks

Each check is colour coded according to four possible states:

Pass | Fall | Manual Check Required  Not Applicable

Pass - the check has passed

Fail - the check has failed

Manual check required - this check must be run manually
Not applicable - not relevant for this installation

The language of each check has been written as a self-explanatory question.

TECHNICAL COMPLIANCE CHECKS (TCF V1)

1 Is the consent string created after affirmative action by the ® IPasél IFEiiI
user? -

If the answer to the question is ‘yes’ the check has passed, if the answer to the question is ‘no’,

the check has failed.

16
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TECHNICAL CHECK <3> X
IS THE CMP ID REGISTERED?

This check fails if the CMP id in the consent string is not associated
with a CMP registered with the TCF.

Policy reference (TCF v1)

Policy Document Chapter ll: Policies for CMPs; 2.1 Applying and registering. CMPs will apply to the
MO for participation in the Framework. The MO will vet and approve a CMP's application according to
procedures adopted, and updated from time to time, by the MO.

POLICY CHECK <1> X
IS 1ST LAYER OF Ul PROMINENTLY DISPLAYED?

Manual steps required for this check
Review the CMP user interface. Launch a separate incognito
window if necessary to simulate a first time user.

Notes

For this check to pass the user interface must as a guideline cover
30% of the screen, and be sufficiently separated from non CMP Ul
content of the page by color or similar.

Policy reference (TCF v1)

Appendix B: Policy Cfa). When providing transparency about Purposes and/or Vendors in combination
with requesting a user’s consent, the transparency and consent prompt must be presented in a modal
that covers all or substantially all of the content of the page. If the modal does not cover all or
substantially all of the content of the page, it must be prominently displayed.

Each check also has an info icon (i) that shows more information, which includes a) failure state
details; b) manual steps; c¢) additional notes and d) the policy reference.

17
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Technical compliance checks

These are checks regarding technical implementation. Most of the technical checks are run
automatically.

TECHNICAL COMPLIANCE CHECKS (TCF V1)

1 Is the consent string created after affirmative action by the ~ @ Fail
user?

7 Are all vendors being set when using global scope? ®

8 s a 3rd party euconsent cookie found when using giobal @

9 Is the local euconsent cookie empty when using global ®
scope?

Legend: [{BasS) JB&il]l Menual Check Required  Not Applicable

18
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Policy compliance checks

These are policy related checks that cannot be run automatically and require a human to review
the user interface to determine if the check passes or fails.

1

POLICY COMPLIANCE CHECKS (TCF V1)

Is 1st layer of Ul prominently displayed?

Are all Purposes shown in the 1st layer of the user
interface?

Is a link to Vendors provided in the 1st layer of the user
interface?

Are calls to action of equal visual prominence?

Is the user informed of their right to withdraw consent at any
time in the 1st layer and how to do so?

Are the consequences of consenting or not consenting
explained in the 1st layer?

Is the user informed that access to information on their
device is taking place by third parties in the 1st layer?

Is the user informed that their personal data is processed by
third parties in the 1st layer, with examples of such data?

& 9 €@ 9 6 @ @6

Pass||Fail |

o

|Pass| | @']

19
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CMP information

This section shows all the information that has been retrieved about the CMP running on the
site. The section heading shows the name of the CMP if it has been identified.

CAPTIFY TECHNOLOGIES LIMITED

CMP information

CMP id
CMP is a service
TCF version

CMP API
Indicates whether the CMP API was found.

__cmp found
__cmpLocator iframe found

CMP API - ping

Details the response from the ping function.

ping response
cmpLoaded
gdprAppliesGlobally

29
yes

yes
no

yes
yes
no

20
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CMP API - getConsentData

Details the response from the getConsentData function.

getConsentData response yes
gdprApplies yes
hasGlobalScope no

CMP API - getVendorConsents

Indicates whether there was a response from the getVendorConsents function.

getVendorConsents response yes

CMP API - getPublisherConsents (optional)

Indicates whether there was a response from the optional getPublisherConsents function.

getPublisherConsents response no

CMP API - getVendorList (optional)

Indicates whether there was a response from the optional getVendorList function.

getVendorList response yes

pubvendors.json (optional)

Indicates whether a pubvendors.json file is available and if yes, provides a link to it.

pubvendors.json exists yes

21
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Consent string data

This section shows information extracted from the consent string.

CMP version 2
Consent string version

Vendor list version 2
Max vendor id 612
Consent screen 0
Consent language en

Consent strings

When you run the CMP Validator it loads the consent strings found at that point in time.

The tool identifies all the consent strings available. It checks in three places: the CMP JS API, a
local ‘euconsent’ cookie and a global ‘euconsent’ cookie.

The default consent string used by the publisher site is always shown first - if the consent string
is available from the CMP JS API it is retrieved from there, if not, from the local cookie. The
source of the default consent string is shown as either ‘via CMP JS API’ or ‘via local cookie’.

22
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In order to understand how CMPs are working, it is possible to load a different consent string.
This is especially useful to view the contents of the global consent string. The ‘current’ consent
string being viewed and any that match it are always highlighted in green.

Consent string - default (via CMP API getConsentData)

Consent string - local cookie

Consent string - global cookie

BOha2730ha273AKASBENCV-AAAANST 9 9uz Ov_ v f 33e87 9v_|
7 - u_-3zd4u_1vi99yfm1-7etrdtp_87ues2_Xur_ 59 3z3 9phPrsk89r6337Ag

23
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Any consent string that is different to the current consent string being viewed is shown
underlined which means you can click on it to load the contents of that consent string.

When clicking on a different consent string the CMP Validator will reload, showing the contents
of the selected consent string. That consent string then becomes the ‘current’ consent string
and is highlighted in green.

Consent string - default (via CMP API getConsentData)

BObI8LdOg2SVWAJACAENAC-AAAAMRY 9 7 _9uz Gv_r ff_ 3nWO0739P1
A_r_Oz_rm_-zzV44_ [pQQRCEAAAAAAAAAAAAAAAAAAAAAAAAAAAGAAAAAAABA
AAAACA

Consent string - local cookie

BODbI8LdOg2SVWAJACAENAC-AAAAMRTY 9 7 _9uz Gv_r ff 3nWO0739P1
A 1 Oz rm_-zzV44_|pQQRCEAAAAAAAAAAAAAAAAAAAAAAAAAAAGAAAAAAABA
AAAACA

Consent string - global cookie

BOha2730ha273AKASBENCV-AAAANST 9 Quz Ov v f 33e87 9v |
7 - u_-3zd4u_1vi99yim1-7etr3tp_87ues2_Xur__ 59 3z3 9phPrsk89r6337Ag

Consent string - manual (paste a consent string below)

There is also a facility to paste in any consent string manually to see the contents of that string.

Important note: compliance checks should be ignored when viewing a different consent
string.

24
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Cookies
The CMP Validator reports on the names of cookies which contain the ‘euconsent’ or
‘eupubconsent’ string.

Local cookie names eupubconsent
Global cookie names euconsent
Purposes

The purposes allowed in the consent string are shown colour coded, green for ‘yes’, red for ‘no’.
This makes it easy to change the purpose settings in the CMP user interface and check whether

the consent string reflects those changes. The purpose id is shown in brackets next to the
description.

Purposes allowed

25
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Vendors

The vendors allowed in the consent string are shown colour coded, green for ‘yes’, red for ‘no’.
As above, this makes it easy to change the vendor settings in the CMP user interface and check
whether the consent string reflects those changes. The vendor id is shown in brackets next to
the name.

>
3
Q
(%))

Publisher standard purpose consents

If set, the publisher’s standard purpose consents are shown here.

Publisher standard purpose consents

2
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Publisher custom purpose consents

If set, the publisher’s custom purpose consents will be shown here.

Publisher custom purpose consents

n/a

Tags that contain the consent string

Three sections at the bottom shows any <SCRIPT>, <IFRAME> or <IMG> tags in the page that
contain the consent string.

https://s.cpx.to/fire.js?pid=12097 &ref=&hn_ver=108&fid=f9371d9b-a87e-4b22-89a4-1db
0c72e8ebf&gcv=B0Oha2730ha273AKASBENCV-AAAANST 9 9uz_Ov_v
_F 33e87 9v | 7 - u -3zd4u_1vfO9yfm1-7etr3tp 87ues2 Xur_ 59 3z3 9phPrs

k89r6337Ag

https://ps.eyeota.net/pixel?pid=9c9gdbu&sid=26&t=ajs&cat=demand&c_b=1&gdpr=1&
gdpr_consent=BOha2730ha273AKASBENCV-AAAANSY 9 9uz Ov v f
_33e87_9v_| 7 - u_-3zd4u_1vfO9yfm1-7etr3tp_87ues2_Xur__ 59 3z3 9phPrsk8
9r6337Agé&c_|=266&c_s=0

https://ps.eyeota.net/pixel ?pid=9c9gdbu&sid=26&t=ajs&cat=tv&c_b=1&gdpr=1&gdpr_c
onsent=BOhaz2730ha273AKASBENCV-AAAANSY 9 Suz Ov v f 33e8
7 9v | 7 - u -3zd4u_1vf99yfm1-7etr3tp_87ues2_Xur__ 59 3z3 9phPrsk89r6337

Agé&c |=257&c _s=0

Summary - tags that contain the consent string

This section shows the number of tags found with the consent string and the maximum length of
the URL.

Number of tags 3
Max length (bytes) 240

27
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No consent string found

If no consent string is found - for example if you run the CMP Validator before consent has been
given, you will see the following.

Radio Times Home | TV and Rac. X - - C &
« > C 0O & https://www.radiotimes.com w B o L5
iab: CMP VALIDATOR X

UNKNOWN CMP (NO CONSENT STRING FOUND)

CMP information

CMP id n/a
CMP is a service n/a
CMP JS API

CMP JS API found yes
CMP loaded yes
GDPR applies globally no

Has global scope? n/a

Consent string data

CMP version n/a
Consent siring version n/a
Vendor list version n/a
Consent screen n/a

Presented by IAB Europe

Information with no value

If a particular data item has no value, it will be shown as ‘n/a’.
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CSV Results

There are three options available in the footer of the Validator that allow to you manage CSV
Results.

Save to CSV | Download CSV | Clear CSV Resuits Presented by IAB Europe (v1.1)

Save to CSV

You can save all the results for the current site by clicking on ‘Save to CSV’. The data saved will
include the results for all compliance checks as well as all the CMP Information shown. You can
save data for multiple sites.

Data saved will persist across browser sessions (browser local storage is used).

Important note: do not save to CSV from an incognito browser, as the data will not be
saved to the same location and will be lost when the incognito browser is closed.

Download CSV

Click on ‘Download CSV’ to download all the data for all sites saved to date.

Clear CSV Results
Click on ‘Clear CSV Results’ to delete all CSV data for all sites.
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Testing a site using ‘incognito’ mode

Many of the checks in the Validator require simulating a first time user experience, so that the
user interface of the CMP is shown on a given site.

This can be difficult if you have already visited a site, as the CMP will know you are an existing
user if a consent string is present and the user interface will not be shown. An easy way to
simulate a first time user experience is to launch a window in Chrome’s ‘incognito’ mode. This
creates a browser window with a clean slate where there are no cookies and no data in local
storage (an alternative browser data storage facility similar to cookies) and therefore allows you
to visit a site as a first time user, which should trigger the CMP. Follow these steps to use
Chrome’s incognito mode:

1. Choose Settings > New incognito window

= (m] X

New Tab -

& cC o (G iab:

25 Apps  For quick access, place your bookmarks here on the bookmarks bar. Import bookmarks now...
New tab Ctrl+T
New window Ctrl+N
New incognito window  Ctrl+Shift+N
History 4
Downloads Crrl+)
Bookmarks >
Zoom - 100% + o :
Print. Ctrl+P
Cast...
Find Ctrl+F
More tools 4

Search Google or type a URL .!;
Edit Cut Copy Paste
Settings
Help >
m| Q (8 [ 1° B
UK Home Quantcast Google Drive Mirror Online Trello
o
Mmh - MH + -
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2. Visit publisher site - you should see a CMP as a first time user

RT Radio Times Home | TV and Rad/ X +

< C (0 @& https//www.radiotimes.com

IMMEDIATE
MEDIA*

We value your privacy

We and our partners use technology such as cookies on our site to personalise
content and ads, provide social media features, and analyse our traffic. Click below
to consent to the use of this technology across the web. You can change your mind
and change your consent choices at anytime by returning to this site.

Set preferences
PO Powered by
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I’'m a CMP, what do | have to do?

All CMPs must use the Validator to test that their software complies with the technical
specifications and policies of the TCF.

This section assumes you have read through this user guide carefully to understand how the
Validator works.

As a CMP you must do the following:

Run the Validator on a site where your CMP is installed
Go through each of the manual checks

Send CSV results to IAB Europe

Resolve any issues found within 30 days

i

Run the Validator on a site where your CMP is installed

Once you have installed the Validator you need to browse to a site where your CMP is running
and simulate a first time user experience, so that the consent string analysed by the Validator is
created by your CMP and not another CMP (this is only relevant if your CMP is configured for
global scope).

If you are a new CMP and have no live installations, you may use a staging site where your
CMP is being tested.

Follow these steps:

1. Open a standard Chrome browser window (not an incognito window)

2. Browse to a site where your CMP is running

3. Simulate a first time user experience so that your CMP appears - delete any cookies as
necessary to trigger your CMP

4. Accept the default settings

5. Run the Validator
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The Validator will appear and you will see the results of the technical compliance checks that
run automatically. This will be the main window where you will register the results of each
manual check.

Go through each of the manual checks

You must now indicate ‘Pass’ or ‘Fail’ for each check in the main window as stated above. To
do this you need to launch a separate incognito window for each manual check, determine
whether the check has passed or failed, and record the result in the main window.

[ Radio Times Home [ TVandRec x| + L W7 Radio Times Home [TV and Rad. X+
€ 5> C 0 @ hups//wwwradiotimescom a x @ 0 6 u o <« C 0 & hips//wwwradiotimes.com
. CMP VALIDATOR
iab: &
Legend: |88 R Menusl Check Requied ot Applicable
POLICY COMPLIANCE CHECKS (TCF V1)
1 Is 1st layer of Ul prominently displayed? @ | [Pass|[Fail .
We value your privacy
,  Areall Purposes shown in the 1st layer of the user OB
! ass |[Fail
interface?
3 Is a link to Vendors provided in the 1st layer of the user @ || (Pass|Fail We and our partners use technology such as cookies on our site to personalise
interface? content and ads, provide social media features, and analyse our traffic. Click below
| S —— - p p = = to consent to the use of this technology across the web. You can change your mind
e calsito acton ofequetvisual promincnce 2 @ | [Pass||Fail and change your consent choices at anytime by returning to this site.
Is the ser informed of their right to withdraw consent at any .
5 fime in the 1st layer and how to do s0? O P=ssFai
Are the of ing or not i
m 6 explained in the 1st layer? O Pss)Fall
Is the user informed that access to information on their
7 device is taking place by third parties in the 1st layer? @} j(Pass[Fai
Save 10 CSV | Download CSV | Clear CSV Results Presented by IAB Europe (v1.1) S :

Important note: indicating ‘Pass’ or ‘Fail’ for a check in an incognito window will be lost
when that window is closed. You must ONLY use the main window to indicate the result
of each check.

Additional important note: if you refresh the page in the main window you will lose all the
data entered for manual checks and you will need to start afresh. Opening and closing
the Validator will not lose data entered for manual checks.

Before you run each manual check, click on the info icon (i) which will provide more information
about the check and the steps required.
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Send CSV results to IAB Europe

When you have indicated ‘Pass’ or ‘Fail’ for all of the manual checks, you can save your results
and send them to IAB Europe.

Follow these steps:
1. Click on the ‘Save to CSV’ option at the bottom of the Validator

2. Download the CSV by clicking on the ‘Download CSV’ option
3. Send the CSV file to tcf.compliance@iabeurope.eu

Resolve any issues found within 30 days

If any of the checks have failed, you must fix the issues within 30 days and re-send the test
results to IAB Europe as above.

Failure to fix all issues will lead to the deactivation of your CMP ID.
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Frequently asked questions

What is the IAB Europe CMP Validator (the Validator)?

The IAB Europe Consent Management Platform (CMP) Validator is a tool that validates whether
a CMP’s code conforms to the technical specifications and protocols and policies detailed in the
IAB Europe Transparency & Consent Framework (TCF).

Why was the Validator developed?

Publishers and technical vendors use CMPs to provide transparency, and collect, store, and,
where appropriate, share consent information across the advertising ecosystem in order to
ensure compliance with the General Data Protection Regulation (GDPR). Today, more than 150
CMPs are registered with the TCF and fall under two categories: (1) those provided for use by
multiple publishers and (2) those built in-house by publishers. A CMP’s failure to accurately read
and record consumers’ choices could not only subject publishers and their technical vendors to
financial penalties but also reduce publishers’ revenue and buyers’ opportunities. The |IAB
Europe CMP Validator exemplifies the association’s commitment to support the industry’s
compliance with GDPR and the longer term commercial sustainability of the industry sector.

Who developed the Validator?

Developed by IAB Europe, the Validator is a comprehensive testing tool for use by all TCF
registered CMPs. The tool has been developed with ease of usage and comprehensive
feedback in mind - it therefore has a Ul and a data capture process. It is foremost a tool that has
been developed to enable all CMPs to be fully aware of what is needed to comply with the
Technical Specifications and Policies of the TCF.

What was involved in the development of the Validator? Has it
been tested in market?
The Validator has undergone a rigorous process of development over a number of months that

has involved beta testing and industry feedback throughout. CMP engagement in the process
from both categories (service providers and publishers own CMPs) included Didomi, OneTrust,
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Crownpeak, Admiral, Schibsted, Conversant, Quantcast, Xandr as well as Group M and the
Guardian. Their feedback has been invaluable enabling IAB Europe to deliver a ‘stand out’ tool.

Where can | find the CMP Validator and how do | install it? Who
can use the Validator?

The Validator is a Chrome extension. This enables the tool to analyse live CMP installations on
any site. The tool is only available to CMPs registered with the TCF, or publishers running an
IAB TCF registered CMP. To request access CMPs are asked to send an email from their
organisation’s domain to: tcf.compliance@iabeurope.eu.

What operating systems are compatible with the Validator?

The extension can be used in the Windows or macOS versions of Chrome. It is not possible to
add an extension to mobile or tablet browsers.

Does the Validator run on mobile devices?

No, unfortunately browser extensions only run on the desktop version of Chrome. If you have an
in-app or non-Web based CMP please submit the appropriate form below as part of the
compliance process instead of using the Validator:

e V1.1 non-Web based CMP form
e V2.0 non-Web based CMP form

| have a non-Web based CMP, can | use the Validator?

No, unfortunately browser extensions only run on the desktop version of Chrome. If you have an
in-app or non-Web based CMP please submit the appropriate form below as part of the
compliance process instead of using the Validator:

e V1.1 non-Web based CMP form
e V2.0 non-Web based CMP form

36


mailto:tcf.compliance@iabeurope.eu
https://forms.gle/zVrb3DHRe4fXqRtQA
https://docs.google.com/forms/d/1P7WyUJ4gzzAzyxmLfl0ZkVueQMH61koxNoQjgzG39bc
https://forms.gle/zVrb3DHRe4fXqRtQA
https://docs.google.com/forms/d/1P7WyUJ4gzzAzyxmLfl0ZkVueQMH61koxNoQjgzG39bc

rope

iab:

IAB EUROPE CMP VALIDATOR USER GUIDE / JULY 9TH 2019

How will the Validator be used in market?

The Validator will be principally used to test new CMPs for compliance before they are
published in the registration process. It will also be used to test CMPs prior to annual renewal of
their registration. All CMPs who are currently registered in the TCF will be invited by IAB Europe
who is the managing organisation (MO) of the Validator to request access to the Validator and
complete the test, save and download the results to a CSV file and return this file to the MO.
There will be a time limit of 30 working days to return the test on receipt of access to the
Validator. All new registrations, post the launch of the Validator, will be required to take the test
and demonstrate operational compliance before they are issued with a CMP ID that enables
them to participate in the TCF.

Who verifies the operational compliance of the test?

IAB Europe, the MO of the Validator, will verify the operational compliance of the test.

What is the validation process for existing CMPs?

All CMPs who are currently registered will be invited to complete the test, save and download
the results to a CSV file and return this file to the MO. The MO will confirm if the CMP is
successfully validated.

What is the validation process for new CMPs?

All new CMP registrations will be required to take the test and demonstrate operational
compliance before they are issued with a CMP ID that enables them to participate in the TCF.

Will all Validator testing be managed by CMPs on a
self-assignment basis?

All CMPs will be asked to take the test and return their results to the MO. The MO will also run
monthly independent checks on CMP installations on publisher sites and follow up any failed
tests.
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If a CMP does not pass the validation tool operational
requirements, what will be the next steps?

If a CMP returns a test that shows failures then the MO organisation will ask the CMP to rectify
the failures within 30 days, re-run the test and return their results.

Who will be informed if a CMP does not comply in the given
timeframe?

In the instances where a CMP has failed a test and does not rectify the failures within the given
period of 30 days the CMP will be advised by the MO that they have 14 days to complete a
successful test after which their CMP ID will be deactivated. The community of registered TCF
Vendors will be advised that the CMP ID that has failed the test is deactivated until further
notice. The CMP will be asked to notify ALL publisher sites that are using their CMP.

Will the MO make public the results of the testing?

The MO will notify all vendors as part of the operational management of the TCF that a Consent
String sent by a CMP deactivated from the Framework is no longer valid. The CMP will also be
removed from the list of registered CMPs. The Validator is principally a tool to support those
who are operating in the Framework. Test failures can arise for a variety of reasons and in most
instances we anticipate that any issues that the test identifies will be resolved swiftly. The test is
there to support the community of CMPs and ensure that they fully understand both the
technical specification and the Policy of the TCF. Ultimately providing, in the first instance, a
guide for the MO and the CMP. Therefore only test failures that result in deactivation will be
more widely notified.

What does the MO hope to achieve through the implementation of
the Validator?

There are 180 plus companies registered as CMPs in the TCF. Each of these organisations
must build functionality from the common technical specification that will interact flawlessly with
other organisations in the digital advertising ecosystem. It is incumbent upon the industry to
ensure that the organisations listed as CMPs are in fact able to perform in that role and that the
success of the TCF is not undermined by ‘actors’ who do not correctly interpret the TCF
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protocols. The MO is therefore committed to working with the registered CMPs to ensure that all
are compliant in the context of the Validator.

Is it likely that the Validator will accelerate CMP deactivations?
What will be the impact on the TCF?

The Validator has been developed to support CMPs with the implementation of the TCF and the
compliance of publishers’ websites with GDPR. It is hoped that all registered CMPs will respect
this important investment made by the MO and will work collaboratively as a community to
ensure that operational compliance is achieved by all. This respect must go ‘hand-in-hand’ with
the understanding that compliance is crucial to the success of the TCF and that the MO needs
to have the facility to enforce. It is not anticipated that this will result in a level of deactivation
that will negatively impact the TCF but will drive higher levels of exemplary implementations.

Is the Validator able to test for both TCF version 1 and TCF
version 2 operational compliance?

The Validator in its first iteration has been built to test TCF version 1 compliance. There will be
in due course an iteration of the Validator that will test TCF version 2 operational compliance.

If a complaint is raised with a DPA about a CMP registered with
the TCF, what is the process?

On receiving notification of a complaint from a DPA the CMP will be deactivated from the
Framework by the MO. An investigation into the cause for complaint will then be led by the MO,
liaising with both the CMP and the DPA as appropriate.

What is the deactivation process?

CMPs that register with the TCF are issued with a CMP ID number and a DNS zone for their
consensu.org sub-domain. If a CMP is deactivated their ID is removed from the CMP
registration and their DNS zone is deactivated. Additionally all vendors who are registered in the
TCF are advised that the CMP ID is deactivated and any consent strings generated by this CMP
ID are invalid.
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What is the enforcement process?

The enforcement process starts after a failure of a Validator test. The CMP is advised they have
30 days to implement development changes to ensure a successful test. Post the 30 day period
that closes with a continuing failure of the test the CMP is advised that their CMP ID will be
deactivated within 14 days. The exception to this process is a deactivation that results from a
DPA natification. In these instances CMP ID deactivation is immediate.

How do | get the latest version of the Validator?

The Validator is self-updating. Most of the time you will simply be using the latest version of the
Validator without realising it. If there has been a recent update and you cannot see a new
feature, you may need to clear your cache:

Settings > More tools > Clear browsing data...

Make sure you only clear ‘Cached images and files’ for the last hour to avoid logging yourself
out of other sites.

Clear browsing data

Basic Advanced

Timerange  Last hour -

Browsing history
[0 clears history from all signed-in devices. Your Google Account may have
other forms of browsing history at myactivity.google.com

Cookies and other site data
[0 signs you out of most sites. You'll stay signed in to your Google Account so
that your synced data can be cleared.

Cached images and files

Frees up less than 320 MB. Some sites may load more slowly on your next

visit.
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